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Introduction
Address Database is a extremely powerful electronic name and
address book.  Since it is a Windows program, it is simple to use.  

Features of Address Database
Address Database allows you to:

~ Store all your names and addresses 

~ Store notes about each person in your address book.  If
you have previously stored notes for a person, the notes
button contains  asterisks  next  to  it  to  alert  you of  the
stored notes

~ Change  and  delete  information  in  your  address  book;
Quickly find a particular person in your address book

~ Undelete (restore) names previously deleted;  once you
are sure you will never need them, you may purge your
undeleted names

~ Maintain a list of people you generally send holiday cards
and gifts to;  print a report of the holiday list

~ Print  a  phone  list  or  address  book  of  names  in  the
address book; customize the report by choosing the font
size,  font  characteristics,   the  number  of  lines  on  the
page,  how many lines to skip between names and the
number of lines to skip prior to printing the page

~ Print mailing labels of people you choose; print multiple
copies of these labels

~ Keep a list of your file folders;  print file folder labels

~ Copy a single field and paste it to another field; or copy
all  information  for  a  person  and  paste  it  into  another
application (such as Notepad, Write, Word, etc.)

~ Filter  your  address  book  so  that  only  certain  people
appear  (based on their  category or  any other criteria).

_____________________________________________________________________________
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You may specify wildcards when filtering on this criteria

~ Keep a "To Do List" to help you get more organized 

~ Import names and address from other applications

~ Export  names and address from Address  Database to
other applications

~   Customize the mailing labels to use any type of labels.
You simply tell Address Database the characteristics of
your labels and it handles the rest

~ Automatically  dial  any  of  the  numbers  in  your  phone
book by simply clicking a button

~ Merge  two  files  together  to  create  a  consolidated
address book

~ Send Pragmatic Software suggestions for future releases

New Address Database 2.0 Features
The  latest  release  of  Address  Database  contains  the  following
improvements:

~ New interface that sports a fresh 3-Dimensional look.

~ Increased functionality from the main Address Database
screen:  

1.  "Filter" has been added as a button on the screen.  
Once you have filtered for particular names, the 
"Filter" button becomes "View All" to allow you to
easily turn off the filter. 

2. "Dial" buttons have been added to allow you to tell
Address Database to dial the number for you.

3. The "Notes" button has been improved to be 
displayed as "Notes (***)" for each name that has
notes stored.

~ New EDIT / PREFERENCES menu item that allows you
_____________________________________________________________________________
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to  customize  report  layouts,  screen  preferences  that
allow you to specify a default  category if  one was not
entered, mailing label preferences that allow you to use
any type of  labels instead of  forcing you to use Avery
labels, and dialing preferences.

~ You no longer have to specify whether you are using a
Laser or Dot Matrix printer.

~ You no longer have to specify "Day Timer Jr" paper to
create  a  report  for  your  Day-Timer.   Simply  set  the
Report Preferences to determine the layout of the report
and you may print the report in any format, for any type
of binder.

~ Increased flexibility in filtering your information.  Prior to
this release, you could only filter based on category.  You
may now filter based on any field stored.  You specify
wildcards  to  filter  based  on  specific  criteria.   For
example, if you would like to filter all names that begin
with Mil,  specify the wildcard "Mil*" in the "Last Name"
field of the filter screen.

~ Better file integrity.  For users that work on a network, the
file is actually closed and reopened each time a record is
changed or added.   This prevents loss of  data due to
network crashes.

~   A new report has been added, called the Address Book
(Compressed) report.  This is a small-font report that lists
all names and addresses in a one-line per record format.

_____________________________________________________________________________
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How to use Address Database
The main screen for Address Database contains a Summary List
which gives you a preview of the names and phone numbers in
Address  Database.    Each  time  you  click  on  a  name  in  the
Summary List, the detailed information is displayed on the bottom
half of the screen.   The total number of names is displayed along
with the total number of names that have been deleted but not
purged.

Finding a Name
To find a name in the Address Database,  click EDIT /  FIND or
press CTRL + F.  The cursor will be placed on the "Find this Last
Name" field on the screen.  Enter the "last name, first name" and
press TAB or ENTER.  The Summary List will show the first name
that matches the name entered.  If no match is found, it displays
the name that is greater than the one entered.

Applying Changes
To change information for a person, enter the new information and
press the "Change" button.  Notice that you can not change the
last or first name because they are the key to the file.  To achieve
this,  change  the  last  and  first  name  and  press  "Add".   Then
"Delete" the original name.

Adding New Names
To add a new person, click on the "Clear" button.  This clears all
the fields for entry.  Enter information about the person, including
the phone number if  applicable.    Once done,  press the "Add"
button.   If you did not specify a primary phone by clicking next to
the phone number, Address Database will automatically click the
first phone that was entered.  This tells Address Database to to
use this phone number in the summary above.  You may change
this by clicking the primary button for another phone number.  

Deleting Names
To delete an existing person,  access the person by clicking on the
person in the Summary List.  Then click the "Delete" button.  It will
ask you if  you really want to delete this person.  Press YES to
delete and NO to cancel.  

_____________________________________________________________________________
_

Pragmatic Sofware Co.  / 6728 Bellehave Drive / Plano TX 75023        -        Page 8



Address Database 2.0                                                                        User's Help Guide
____________________________________________________________________________

Adding Notes to a Name
To add notes for a person, access the person by clicking on the
person in the Summary List.   Then click the "Notes" button.  Enter
notes in the Notepad and exit when done.  Each time you press
"Notes"  for  this  person,  the notes that  were stored will  appear.
Notice  that  if  no  notes  are  stored  for  the  person,  the  button
displays "Notes".   If  there are notes stored, the button displays
"Notes (***)".  This is done to alert you as to the people you have
notes stored.

Creating a Holiday List
To have a person appear on the Holiday List report, bring up the
person by clicking on the person in the Summary List.  Then click
the Holiday List.  Click "Change" to save the changes. 

Intelligent Zip Code
Address  Database  contains  an  "Intelligent  Zip  Code"  which
automatically enters the city and state if the zip code is the same
as any others in the database.

Intelligent Phone Numbers
Address  Database  contains  "Intelligent  Phone  Numbers"  which
automatically reformats the phone number you enter to the format
111-111-1111 x1111.  It will also convert alphabetics to numerics
(i.e. 800-94PHONE is converted to 800-947-4663).

Dialing a Phone Number
You can have Address Database dial a phone number for you by
simply clicking the "Dial" button next to the phone number in the
Detailed Information section of the screen.  Once this is clicked, it
will display the number it is dialing.  Simply pick up the phone and
press the "OK" button.

Notice that Address Database will  prefix the phone number if  a
prefix is specified in the EDIT /  PREFERENCES screen.   Also,
Address  Database  automatically  prefixes  phone  numbers  that
contain an area code with a '1'.

Shortcuts
Address  Database  allows  you  to  use  the  following  keys  as
shortcuts.  By pressing these keys, the function is automatically
executed.  (CTRL + LETTER means to hold down the CTRL key
and press the letter.)

_____________________________________________________________________________
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~ File New CTRL + N
~ File Open CTRL + O
~ File Save As CTRL + S
~ Copy Field CTRL + C
~ Paste CTRL + V
~ Find Name CTRL + F
~ Undelete CTRL + U
~ Print Mailing Labels CTRL + M
~ View All Names CTRL + A
~ Filter Names CTRL + I
~ To Do List CTRL + T
~ Help F1

Hardware Required
Address Database is designed to work with:

~ IBM  286  or  higher  compatible  computer  running
Microsoft Windows version 3.0 or higher

~ A monochrome or color EGA, VGA, or better monitor
~ A hard disk
~ 1 Megabyte of memory
~ Any type of printer
~ Windows Notepad (installed)
~ Windows Write (installed)

Installing Address Database
To  install  Address  Database,  run  SETUP.EXE.   Or,  to  install
Address Database manually,  following these steps:

1. Put the floppy diskette containing Address Database in
the a: or b: drive.   

2. Create a new directory on your hard drive for Address
Database.  (i.e.   C:\ADDRDB).  You can do this by using
Windows File Manager (FILE / CREATE DIRECTORY...).

3. Copy  all  files  from  the  floppy  to  the  new  Address
Database directory on the hard drive.   Again,  use File
Manager (FILE / COPY).  Copy all files (i.e. *.*).

4. Create an icon in Program Manager so that you can run
_____________________________________________________________________________
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Address Database by double clicking the icon.  Do this
by  using  Windows  Program  Manager  (FILE  /  NEW  /
PROGRAM ITEM / DESCRIPTION (Address Database) /
COMMAND  LINE  (C:\ADDRDB\ADDRDB.EXE)  /
WORKING  DIRECTORY (C:\ADDRDB)   /  SHORTCUT
KEY (CTRL +  ALT  +  A).   This  will  allow  you  to  run
Address  Database  by  double  clicking  the  icon  or
pressing  CTRL +  ALT +  A).   Note:  If  you  would  like
Address Database to automatically open a file when it
begins, make the WORKING DIRECTORY (C:\ADDRDB
filename.adb).

5. For a detailed description of all the files used by Address
Database, read INSTALL.TXT.

Upgrading to Address Database 2.0
If you have a previous version of Address Database installed and
would like to install the new version, simply copy 3 files to your
Address Database directory:  ADDRDB.INI,  ADDRDB.EXE, and
ADDRDB.WRI.

_____________________________________________________________________________
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FILE MENU
The File  Menu in  Address Database allows you to create  new
files, open existing files, import a file, export a file, merge two files
together, and exit Address Database.

New (Create a new file)
To create a new Address Database file, click FILE / NEW or press
CTRL + N.  It will prompt you for a file name.  Enter the name of a
file that is not currently being used.  The extension of the file name
must be ".ADB" (i.e. NEWFILE.ADB).  Press OK to create a new
file or click the CANCEL button to cancel the operation.  

Open (Open an existing file)
To open an existing Address Database file, click FILE / OPEN or
press CTRL + O.  It will  display a list of files.  Click on the file
name you wish to open.  Click OK to select the file or  click the
CANCEL button to cancel the operation.  

When  you  initially  start  Address  Database,  it  automatically
remembers the last file you had open, and will open that file.  

Optionally, you may automatically open a specific file each time
Address Database is started by setting the properties in Program
Manager to pass Address Database the file name.  For example,
to open myfile.adb each time you execute Address Database, set
up  the  properties  in  Program  Manager  as   C:\ADDRDB\
ADDRDB.EXE MYFILE.ADB.

Close (Close an open file)
To close the file that is currently displayed in  Address Database,
simply open a new file.  It automatically closes the opened file.  

Save As (Save the file as a new name)
To save the currently opened file as a new name, click FILE / 
SAVE AS or press CTRL + S.   Notice that only the records 
currently in the Summary List are saved.  This allows you to 
"Filter" the list saving only the filtered names as the new file.   Of 
course, you may do a  VIEW / ALL and a FILE / SAVE AS to save 
_____________________________________________________________________________
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Import (Importing a file into Address Database)
To import a file into  Address Database, click FILE / IMPORT.   A
screen will be displayed that allows you to let Address Database
know the layout of the import file.  This screen also has a list of
instructions at the top of the screen.  To cancel the import, click
the CANCEL button.

To import a file you must do the following:

~ Create the import file in comma-delimited format.  Make
sure  that  the  file  resides  in  the  same  directory  as
Address Database.  

~ Enter the "Import File Name" and "File Name to Create".
The "File Name to Create" should have an extension of
".ADB" (i.e. NEWFILE.ADB).  

~ Choose the fields that appear on the Import file in the
order in which they appear on the file.  Do this by clicking
each field name in the order as it  appears on the file.
Once you click it, you will see it move to the box on the
right.  If a field name is on the Import file but not in the
list, click on the UNDEFINED field name.

~ If you make a mistake,  click the RESET button.

~ Click  the  IMPORT  NOW  button  to  begin  the  Import.
Once imported, a record count will be displayed.  

Note that Address Database does not allow duplicate records, so 
if the imported file has duplicates, the duplicates will be deleted.  

Also, Address Database will store all phone numbers in 111-111-
1111 x1111 format.

_____________________________________________________________________________
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Export (Exporting a file for other applications)
To export a file from Address Database, click FILE / EXPORT.  It
will prompt you for a file name.  Enter the name of a file that is not
currently being used.  Press OK to create a new file or press the
CANCEL button to cancel the operation.  

Once the file is exported, it will prompt you to ask you if you would
like a report showing the layout of the exported file.  The report
contains the file  name exported,  the number  of  records,  and a
record layout of the exported file.  Press YES to print the report
and NO to exit.  The exported file is created in comma-delimited
format.

Merge (Merging two files together)
To merge 2 files together in Address Database, open the file that
will  contain  the names after  the  merge.   Then click  on FILE /
MERGE.  It will display a message telling you that a backup of the
original file will  be created and named "*.BAK", where * is your
original filename.  Press OK.

It will prompt you for a file name.  Click on the file name of the file
to merged with the one that is currently open.  Press OK to merge
the two files or press the CANCEL button to cancel the operation.  

Exit (Exit Address Database)
To exit Address Database, click FILE / EXIT.  

_____________________________________________________________________________
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EDIT MENU
The Edit Menu in Address Database allows you to copy a field,
copy all  information (name, address, etc.),  paste a copied field,
find a particular name, undelete a previously deleted name, purge
the deleted names.

Copy Field (Copy information to Clipboard)
To copy a field on the screen, put the cursor on the field and click
EDIT / COPY FIELD or press CTRL + C.  The contents of the field
will be copied and placed into the Windows Clipboard.

Copy All Information (Copy Name/Address,Etc.)
To  copy  the  name,  address  and  phone  number  of  the  name
currently displayed, click EDIT / COPY ALL INFORMATION.  The
information will be copied and placed into the Windows Clipboard.
The copied text is formatted so that it can be pasted into a word-
processor or text-editor.  An example of what the results look like
are:

Bruce Lee
HardFoot, Inc.
999 Roundhouse Street
Plano, TX  75023
214-144-9864 (Home)

Paste (Paste information from Clipboard)
To paste  a  copied  piece  of  information,  put  the  cursor  on  the
receiving field and click EDIT / PASTE or press CTRL + V.  The
contents of the field will be pasted into the field.

Find (Find a last name)
To find a name in the Address Database,  click EDIT /  FIND or
press CTRL + F.  The cursor will be placed on the "Find this Last
Name" field on the screen.  Enter the "last name, first name" and
press TAB or ENTER.  The Summary List will show the first name
that matches the name entered.  If no match is found, it displays
the name that is greater than the one entered.

_____________________________________________________________________________
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Undelete (Recover deleted information)
To undelete a previously deleted name in the Address Database,
click EDIT / UNDELETE or press CTRL + U.   It  will display all
names that are available to be undeleted.  Double Click the name
to undelete.  

Once  double  clicked,  <<UNDELETE>>  appears  next  to  the
record.  Double click again to turn off <<UNDELETE>>.   To turn
off all <<UNDELETE>>, press the RESET button.  To undelete the
items marked <<UNDELETE>>, click the UNDELETE AND EXIT
button.    Click  on  CANCEL  to  cancel  the  operation  without
undeleting any named.

Purge Deletes (Get Rid of Undeletes)
To purge the deleted names in the Address Database, click EDIT /
PURGE  DELETES.    It  will  physically  delete  from  the  file  all
records marked as deletes.  Notice that the new Delete Count is
zero.  Once this is done, an Undelete can no longer be done on
those names that were purged

Purge Deletes on Exit
To purge the deleted names in the Address Database every time
you  open  a  new  file  or  exit  Address  Database,  click  EDIT  /
PURGE DELETES ON EXIT.   It will physically delete from the file
all records marked as deletes each time you open each new file or
you exit Address Database.  

Preferences
To specify report, screen and mailing label preferences, click EDIT
/ PREFERENCES.   Below are the options available:

1. Report Preferences - Enter the following preferences:
A) Font Size in points: Specifies how large to make the

font that is printed on the reports.  The larger the number,
the larger the print.

B) Left Margin Tab: Specifies where to tab prior to printing
the report information.  Increase this value if you wish to
move the printed output to the right.  This is useful when
you are putting your printed report in a binder as to allow

_____________________________________________________________________________
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for the binder holes.
C) Blank Lines at Top: Tells Address Database to skip this

many lines prior to printing the report on the page.  This
can be useful when printing reports on Day-Timer or
smaller than normal paper.

D) Page Break on Line:  Tells Address Database to begin 
printing a new page once the number of lines entered
here has been surpassed.

E) Italics Font: Prints the reports in italics print.
F) Bold Font: Prints the reports in bold print.
G) Page Break on New Alphabet:  Specifies that when a

new alphabet is reached when printing the reports, go to
the next page.  This is useful when printing an address
book  that  is  inserted  into  a  binder  that  has  tabs  by
Alphabet.  For example, Day-Timers has the telephone
book separated by Alphabetic tabs.  If you click this, it will
create each alphabet on separate pages.

H) Skip a Line Between Each Name: Specifies that each
time a name/address is printed on the report, skip a line
before printing the next name/address (double space).

Final note:  If you change the font size, the other preferences
may need to change.  For example, if you change the font size
from  8  points  to  15  points,  you  may  need  to  tell  Address
Database to create a page break on line 35 rather than 55.

2. Screen Preferences - Enter the following preferences:

A) Default Category: Enter a default category which will be
used any time the category field is left blank when adding
new names to your address book.

B) Spaces as Summary List Divider: Check this box if you
do not want to see the double arrows dividing the name
and the primary phone number on the "Summary List" of
the main screen.

C) Allow Non-USA Phone Numbers: Check this box if you
do not want the phone number to be edited.  This will
allow for free-form phone numbers.

3. Mailing Label Setup -  See "Adjust Label Alignment" 
topic under the Labels Menu Section of this User's 
Guide.

4. Dialing Preferences - Click on the appropriate 
Communications port and enter a prefix number to be 

_____________________________________________________________________________
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used when dialing a phone number.  In other words, a 
prefix of "9" will use 9 as a prefix prior to dialing the 
number.   Notice that if the phone number begins with an 
area code, Address Database will automatically dial a "1"
first.

_____________________________________________________________________________
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LABELS MENU
The Labels Menu in Address Database allows you to specify the
type of labels you will be using, obtain mailing label instructions,
print mailing labels, and print file folder labels.

Adjust Label Alignment
To tell Address Database what type of labels you are using click
on LABELS / ADJUST LABEL ALIGNMENT.  From here, follow the
instruction listed on the screen:

1. Choose the font characteristics for the labels.  Specify the font
size  in  points  (the  bigger  the  number  the  larger  the  print),
whether to print in italics and / or bold print.

2. Print the alignment guide on the label paper you will be using.
The alignment  guide should  be printed only  after  you have
specifed the font characteristics.  Once this done, press the
"Print  Alignment Guide"  button.    Once the Alignment  guide
has  been  printed,  use  the  guide  to  answer  the  remaining
questions on the screen.

3. How many Labels are across the page (1 - 3)?   Enter the
number of labels that appear horizontally across the page.  For
example:

1 Label Across 2 Labels Across 3 Labels Across

-  - - - - - 
-  - - - - - 
-  - - - - - 

4. Based on the alignment guide, enter the tab stops for each
column  of  labels.    Look  at  the  Alignment  Gude  that  was
printed on the label sheet.  Find the "Tab=" that is printed in
the first column of labels.  This is the number you must tell
Address Database to tab to prior  to  printing that  column of
labels.  Do the same for the second and third columns.  

5. How many rows of labels are down the page (1 - 20)?   Enter
the number of rows of labels that appear vertically down the
page.  For example:

_____________________________________________________________________________
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     7 Rows 5 Rows 10 Rows

Row 1: - - - - - -  
Row 2: - - - - - -
Row 3: - - - - - -
Row 4: - - - - - -
Row 5: - - - - - -
Row 6: -  - - -

Row 7: -  - - -

Row 8:   - - -

Row 9:   - - -
Row 10:  - - -

6. Based on the Alignment Guide, enter the line each row of 
labels should begin.   Look at the line numbers numbers 
printed on the left side of the Alignment Guide.  Each number 
represents the line number. 

If the first line number that is printed on the first row of labels is
line 3, enter "3" in the "Row 1" field.  If the first line number 
that is printed on the second row of labels is 9, enter "9" in the 
"Row 2" field.  Continue to do this for each row of labels.    

Notice that Address Database will only allow you to enter 
information into the number of fields specified in item (5) 
above.

Once all of the information above is entered, press "OK" to store 
this information.  If you have made mistakes, press the "Cancel" 
button.

Mailing Label Instructions
This describes how to print mailing labels:
_____________________________________________________________________________
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~ Print the alignment guide to determine the parameters to
enter in the "Adjust  Label Alignment" screen.  See the
related topic for details. 

~ Put address label paper in printer.

~ Filter the list so that it displays only the names you wish
to create labels for.  Hint: Use VIEW / FILTER or press
CTRL + I.  To print a single label multiple times, VIEW /
FILTER the label to print, and enter 30 or 36 to print a full
page of labels for this name.

~ Use the LABELS / PRINT MAILING LABELS command,
or press CTRL + M, to begin printing.  

File Folder Instructions
This describes how to print  file folder labels.  Notice that when
these are printed, up to four fields are printed on the file folder
label (last name, first name, company, and title.

To print file folders:

~ Print the alignment guide to determine the parameters to
enter in the "Adjust Label Alignment" screen.  See the  

related  topic for details. 

~ Put address label paper in printer:

~ Filter the list  so that it  displays only the names with a
category of FILEFOLDER.  Hint: Use VIEW / FILTER or
press CTRL + I.  More simply, click YES at the prompt
and it will automatically filter them for you.

~ Use the LABELS / PRINT MAILING LABELS command,
or press CTRL + M, to begin printing.  

_____________________________________________________________________________
_
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REPORTS MENU
The Reports  Menu  in  Address  Database  allows  you  to  print  a
phone list,  address book,  holiday list  of  names and addresses,
and choose whether to print on standard or Day-Timer  Jr. paper.

Print Phone List
Click  on  this  to  create  a  phone  list  of  all  names  currently
displayed.   Notice  that  you  can  print  a  phone  list  of  selected
names  by  first  "Filtering"  the  list  and  then  printing  this  report.
Once done, the total number of names printed is displayed.

Print Address Book
Click on this  to  create an address book of  all  names currently
displayed.  Notice that you can print an address book of selected
names  by  first  "Filtering"  the  list  and  then  printing  this  report.
Once done, the total number of names printed is displayed.

Print Address Book (Compressed)
Click on this  to  create an address book of  all  names currently
displayed.  Notice that you can print an address book of selected
names  by  first  "Filtering"  the  list  and  then  printing  this  report.
Once done, the total number of names printed is displayed.  The
only difference between this report and the Address Book is that
this report has compressed font which allows you to print line per
name/address.

Print Holiday List
Click on this to create an address book of all names that have the
Holiday List field clicked.  

To have a person appear on the Holiday List report, bring up the
person by clicking on the person's  name in  the Summary List.
Then click the Holiday List.  Click "Change" to save the changes. 

_____________________________________________________________________________
_

Pragmatic Sofware Co.  / 6728 Bellehave Drive / Plano TX 75023        -        Page 24



Address Database 2.0                                                                        User's Help Guide
____________________________________________________________________________

VIEW MENU
The View Menu in Address Database allows you to view all names
in  the  currently  displayed  file  or  filter  the  display  so  that  only
certain categories are displayed.

All (View all names in currently opened file)
Click on this to take off all filters.  This will display all names in the
opened file.

Filter (View names based on selection criteria)
To display only the names that meet specific rules, click VIEW /
FILTER or press CTRL + I or press the "Filter" button from the
main screen.   When clicked, it displays a screen that allows you
to enter the information to filter by.  Additionally, it allows you to
choose the categories to include in the display.   To cancel, click
the CANCEL button.

Notice that the screen has detailed instructions on filtering:

~ First enter the selection criteria for each field.  You may
use wildcards.   Below are some examples of  wildcard
patterns you may enter:

Kind of matchingPattern Returns
Multiple characters a*a "aa", "aba", "abbba"
Special characters a[*]a "a*a"
Multiple characters ab* "abcdefg", "abc" Single
character a?a "aaa", "a3a", "aba" Single digit

a#a "a1a", "a2a", "a3a"
Range of characters [a-z] "a", "b", "c"
Outside a range [!a-z] "1", "2", "3" (! = not)
Not a digit [!0-9] "a", "b", "&"
Combined a[!b-m]# "an9", "az1", "a99"

~   Choose  the  categories  that  appear  in  the  AVAILABLE
CATEGORIES box.  Once you click a category, you will
see it move to the box on the right.  This means that this
category will be included. 

~ If you make a mistake, click the RESET button.

_____________________________________________________________________________
_
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~ Click  the  FILTER  NOW  button  to  filter  based  on  the
categories selected.

_____________________________________________________________________________
_
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TOOLS MENU
The Tools Menu in Address Database allows you to display a To
Do  List,  send  the  author  suggestions,  and  purchase  Address
Database (if you are not a registered customer).

To Do List
To open a To Do List, click TOOLS / TO DO LIST or press CTRL +
T.   When clicked, it prompts you for a To Do List file name.  If one
is not found, a sample one is created, named SAMPLE.TOD.  

Use this To Do List each day to record the things you must do
each day, in the future, and to record things that have been done.
At  the  end  of  each  day,  you  may  want  to  save  the  file  as
something  that  you  can  remember,  such  as  the  date.   For
example, you may want to save it as ME010193.TOD which says
it is for "ME", for the date of "010193".   

Make sure you save it with an extension of ".TOD" to let Address
Database know that it is a To Do List.  The To Do List uses the
Windows Notepad and may be printed.

Suggestion Box
To send me a suggestion or to register a problem, click TOOLS /
SUGGESTION BOX.   When clicked, it creates a letter in Notepad
named SUGGEST.TXT.  

Enter  your  name  and  address  and  enter  suggestions  for  new
releases.  You may also use this to identify problems you find with
Address Database.   Print  the letter  and send it  to the address
listed.  Letters will be given prompt attention.

Purchase Address Database
To  purchase  a  copy  of  Address  Database,  click  TOOLS  /
PURCHASE ADDRESS DATABASE.   When clicked, it creates a
letter in Notepad named PURCHASE.TXT.  

Enter  your  name and address and enter  the order  information.
Print the letter and send it to the address listed.  New orders will
be given prompt attention.
_____________________________________________________________________________
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Notice that registered customers will not have this as a menu item.

_____________________________________________________________________________
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HELP MENU
The Help Menu in Address Database allows you to display this
user's guide and display information about Address Database and
it's author.

Address Database User's Guide
Press F1 or click HELP / ADDRESS DATABASE USER'S GUIDE
to display the information that you are reading right  now.  This
information  is  stored  in  Windows  Write  and  is  named
ADDRDB.WRI.    

You may print this for a hard-copy of the manual.  You may use
this as you use Address Database to get help on specific topics.
Use the Windows Write "Find" command to find topics or use F4
(Find / Go To Page...) to jump to a particular page.  

About Address Database
Click HELP / ABOUT ADDRESS DATABASE to display the name
of  the  software,  the  version,  copyright  information,  address  for
purchasing and the purchase price.

_____________________________________________________________________________
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